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AUCTION OF LICENSES FOR THE 700 MHz
GUARD BANDS

CORRECTED ATTACHMENTS

Report No. AUC-00-33-C (Auction No. 33)

The Wireless Telecommunications Bureau (“Bureau”) has issued a Public Notice that
sets forth the filing requirements, minimum opening bids, and other procedural matters
to govern Auction No. 33.1  The Bureau hereby corrects three of the attachments to
the Auction No. 33 Announcing Public Notice.  Specifically, the Bureau has amended
Attachment C to clarify that “Lotus” and “Excel” are not acceptable filing formats.  In
addition, the Bureau has amended Attachment D to add text in explaining the
enhanced license selection screen for use in completing Form 175 (“the short-form”).
Finally, the Bureau has amended Attachment H to correct the instructions for
accessing the FCC network.

Fully corrected copies of Attachments C, D, and H to the Auction No. 33 Announcing
Public Notice are attached.

                                               
1 See Auction of Licenses for the 700 MHz Guard Bands, Scheduled for June 14, 2000, Auction

Notice and Filing Requirements for 104 Licenses in the 700 MHz Guard Band, Minimum Opening Bids and Other
Procedural Issues, (“Auction No. 33 Announcing Public Notice ”) (rel. April 10, 2000).



VIII. ATTACHMENT C

ELECTRONIC FILING AND REVIEW
OF THE FCC FORM 175

Applicants must submit their FCC Form 175 applications electronically using the Commission's
remote access system.  This system will generally be available 24 hours per day.  FCC Form 175
applications must be submitted and confirmed by 6:00 p.m. ET on Tuesday, May 9, 2000.  Late
applications or unconfirmed submissions of electronic data will not be accepted. 

Applicants must press the 175 Submit button on the Submit page to successfully submit their
FCC Form 175.  The electronic filing process consists of an initial filing period and a
resubmission period to make minor corrections.  During each filing period, submitted
applications may be updated and amended multiple times until the filing deadline.

A. Minimum Hardware and Software Requirements

Applicants will need to meet the following minimum hardware and software requirements:

1. Minimum Hardware Requirements

• CPU:  Intel Pentium
• RAM: 16 MB (more recommended if you have multiple applications open)
• Modem:  v.32bis 14.4kbps Hayes compatible modem or faster (recommend 56.6 Kbps)
• Monitor:  VGA or above
• Mouse or other pointing device

2. Minimum Software Requirements

• Operating System: Microsoft Windows 95 or 98

• PPP (Point-to-Point Protocol) Dialer: Use the Dial-Up Networking feature included with
Windows 95/98

• Web Browser:  Netscape Communicator 4.7 is recommended.  However, you can also use
Netscape Communicator 4.5, 4.51, or 4.61 (Internet web browser software).

Note:  To download Netscape Communicator 4.7 free of charge, access the Netscape
download site at http://home.netscape.com/download/

• PDF Viewer:  Adobe Acrobat Reader 3.0 or higher (available at http://www.adobe.com)



• If you wish to use the download feature in the Form 175 Review, you will need a .tar file
extraction utility, e.g., Winzip (available at http://www.winzip.com) or Pkzip for Windows
(available at http://www.pkware.com/download.html).

B. Submitting FCC Form 175 Applications

To submit FCC Form 175 applications electronically, you must first connect to the FCC Network
via a toll-free phone number (877-844-2788) using Dial-Up Networking.  Dial-Up Networking
establishes a point-to-point connection from your PC to the FCC Network.  This point-to-point
connection is not routed through the Internet.

Note:  For instructions on how to connect to the FCC Network using Dial-Up Networking,
see the Accessing the FCC Network Using Windows 95/98 attachment.

After you have connected to the FCC Network, start your Netscape Web browser.  In your
browser’s Location field, enter http://wtbwww34.fcc.gov and then click 175 Submit.

When uploading attachments in FCC Form 175 Submission, applicants may use a variety of file
formats -- including Word 97 or earlier, WordPerfect 6.x or earlier, Adobe PDF, and ASCII text -
- and should verify that the files contain all exhibit information.  Graphics file uploads (e.g.,
.bmp, .tiff, .jpg) and spreadsheets (e.g., Excel, Lotus) are not supported, and graphics images
should not be imported into any word processing files that are uploaded.

After you upload an attachment, check to see if it converted properly by selecting the PDF
filename in the rightmost column. The conversion process generally completes within thirty
minutes.  If you are unable to read this file after it has been converted, please do the following:

1. Re-upload the attachment.

2. If the file still has not converted properly, then simplify the formatting of the file. 

For example, if you are using a Table structure in a WordPerfect document, remove the Table
structure and leave the contents of the table, then re-upload the attachment.

After you have successfully re-uploaded an attachment, please delete the old, unreadable
attachment files.

Applicants must press the Submit Form 175 button on the Submit page to successfully submit
their FCC Form 175.  During each filing period, submitted applications may be updated and
amended multiple times until the filing deadline.

When you have finished, exit your Web browser; then disconnect from the FCC Network.



C. Reviewing FCC Form 175 Applications

Once the FCC has completed the 175 Review process, you can review FCC Form 175
applications electronically via the Internet.  Start your Netscape Web browser.  In your browser’s
Location field, enter http://wtbwww15.fcc.gov and then click 175 Review.

D. Help

For technical assistance with installing or using FCC software, contact the FCC Technical
Support Hotline at (202) 414-1250 (V) or (202) 414-1255 (TTY).  The FCC Technical Support
Hotline is generally available Monday through Friday, from 8 a.m. to 6 p.m. ET.  All calls to the
FCC Technical Support Hotline are recorded.



IX. ATTACHMENT D

GUIDELINES FOR COMPLETION
OF FCC FORM 175 AND EXHIBITS

A.  FCC Form 175

Because of the significance of the FCC Form 175 application to the auction, bidders should
especially note the following:

Applicant Name:   Name given is used as your bidder name in the auction.

Address:  Give a street address (not a Post Office box number) for the applicant.

Applicant Classification:  Applicants must indicate their legal classification.  The FCC Form
175 requires the applicant to classify itself as an individual, joint venture, partnership, trust,
corporation, consortium, association, limited liability company (LLC) or government entity. 

Applicant Status:  Applicants are also requested to indicate their status as a rural telephone
company, minority-owned business and/or women-owned business, so that the FCC can monitor
its performance in promoting economic opportunities for these designated entities.

Bidding Credit Eligibility:  Be advised that this is the sole opportunity applicants have to elect
small business or very small business status and bidding credit level (if applicable), and there is
no opportunity to change the election once the short-form filing deadline passes.

• Small business or very small business applicants should enter the applicable bidding
credit from the drop down menu.  Applicants should be aware that this is the sole
opportunity that they will have to elect the appropriate bidding credit.

License Selection: Applicants should identify all licenses on which they want to be eligible to
bid in the auction.  Be advised that there is no opportunity to change this list once the short-form
filing deadline passes.  It is critically important that you confirm the licenses that you have
selected because the FCC auction system will not accept bids on licenses for which an applicant
has not applied on its FCC Form 175.  Note that there are multiple channel blocks offered in
each geographic area ("Market") and each of these licenses must be selected individually (i.e.,
selecting channel  block A in market MEA001 does not make you eligible to bid on channel
block B in market MEA001).  Each row in this license list represents a single license, shown as
one market and channel block.  Please confirm your license selection, by clicking on the
"Confirm" button.

Authorized Bidders:  Applicants must list the name(s) of the person(s) (no more than three)
authorized to represent them at the auction.  Only those individuals listed on the FCC Form 175
will be authorized to place or withdraw bids for the applicant during the auction.  Note:



Applicants may only share a common authorized bidder(s) if each applicant has selected
separate markets.  See 47 CFR § 1.2105(c).

Certifications:  Applicants should carefully read the list of certifications on the FCC Form 175. 
These certifications help to ensure a fair and competitive auction and require, among other
things, disclosure to the Commission of certain information on applicant ownership and
agreements or arrangements concerning the auction.  Submission of an FCC Form 175
application constitutes a representation by the certifying official that he or she is an authorized
representative of the applicant, has read the form's instructions and certifications, and that the
contents of the application and its attachments are true and correct.  Submission of a false
certification to the Commission may result in penalties, including monetary forfeitures, license
forfeitures, ineligibility to participate in future auctions, and/or criminal prosecution.

Contact person/address:  If the Commission wishes to communicate with the applicant by
telephone or fax, those communications will be directed to the contact person identified on the
FCC Form 175.  Space is provided for an address, telephone number, fax number, and e-mail
address.  All written communication and registration information will be directed to the
applicant's contact person at the address specified on the FCC Form 175.  Applicants must
provide a contact street address; no P.O. Box addresses may be used.

Completeness:  Applicants must submit all information required by the FCC Form 175 and by
applicable rules.  Failure to submit required information by the resubmission date will result in
dismissal of the application and inability to participate in the auction.  See 47 C.F.R. § 1.2105(b).

NOTE: Applicants must press the “Submit Form 175” button on the “Submit” page to
successfully submit their FCC Form 175.

Continuing Accuracy:  Each applicant is responsible for the continuing accuracy and
completeness of information furnished in the FCC Form 175 and its exhibits.  See 47 C.F.R. §
1.65.  It is the FCC's position that during the conduct of an auction, thirty business days from a
reportable change is a reasonable period of time.  Applicants are reminded that they consent to
be audited in the certification section of the FCC Form 175 (see certification item number 6).

B.  Exhibits and Attachments

In addition to the FCC Form 175 itself, applicants must submit additional information required
by the FCC's rules.  Although the FCC does not require a particular format for this information,
it has developed the following guidelines that will facilitate the processing of short-form
applications.  The FCC encourages applicants to submit this information in several attachments
using the following format.

If you find that an attachment has not converted properly to Adobe PDF format, take the
following steps:

1) Simplify the formatting of the file.  For example, if using a Table structure in a
WordPerfect document, remove the Table structure leaving the contents of the table,



re-save the document.
2) Re-upload the attachment.
3) Delete the failed attachment.

NOTE: Applicants should not list their TIN numbers on any Exhibits to their
FCC Form 175s.

Exhibit A - Applicant Identity and Ownership Information:  47 C.F.R. § 1.2105(a)(2)(ii) 
requires each applicant to fully disclose the real party or parties-in-interest in an exhibit to its FCC
Form 175 application.  Each member of an applicant applying to bid as a small or very small
business consortium must provide this information.  The following information is required:

1. General Information

Applicant Status Required Information

General Partnership Name, citizenship, and address of all partners, and the share or
interest participation of each partner

Limited Partnership Name, citizenship, and address of each limited partner whose interest
in the applicant is equal to or greater than 10 percent  (as calculated
according to the percentage of equity paid in and the percentage of
distribution of profits and losses).

Corporation Corporate name and address; and name, title, and citizenship of a
responsible officer or director.

Limited Liability Corporate name and address; and name, address and
Corporation citizenship of all members.

Trust Name, citizenship, and address of trustee.

None of the above Name, citizenship, title or other relation to the applicant, and 
address of a principal or other responsible person

2.  Ownership Information

Applicant Status Required Information

All applicants Name, citizenship, and address of all controlling interests 
of the applicant as defined in Part II.C.1 of this public notice. 

All applicants Name, citizenship, and address of all parties holding 10 percent
or more of any class of stock, warrants, options or debt securities
and the amount and percentage held.



All applicants Name of all parties holding a 10 percent or greater
interest in the applicant and the specific amount held.

All applicants List of any FCC-licensed entity or applicant for an FCC license,
in which

a. the applicant;
b. any party with a 10 percent or greater interest in the

applicant; or
c. a controlling interest (as discussed in Part II.C.1 of this

public notice) of the applicant owns a 10 percent or greater
interest or 10 percent or more of any class of stock, warrants,
options or debt securities. (See also 47 C.F.R. §§ 27.502 and
1.2110)  This list must include a description of each such
entities' principal business and a description of each such
entities' relationship to the applicant.

Example of a.  The applicant owns 10 percent of Company A (an
FCC-licensed entity or an applicant for an FCC license).  The
applicant must list Company A on its Form 175 Exhibit A and
provide the required information.

 Example of b.  Company A owns 10 percent of the applicant and
10 percent of Company B (an FCC-licensed entity or an applicant
for an FCC license).  The applicant must list both Company A and
Company B on its Form 175 Exhibit A and provide the required
information.

Example of c.  A owns 55% of the applicant and owns 10 percent of
Company B (an FCC-licensed entity or an Applicant for an FCC
 license).  The applicant must list both A and Company B on its
Form 175 Exhibit A and provide the required information.

All applicants List of all parties holding indirect ownership interests in the
applicant as determined by successive multiplication of the
ownership percentages in each link of the vertical ownership chain,
that equals 10 percent or more of the applicant, except  that if the
ownership percentage for any link in the chain exceeds 50 percent or
represents actual control, it shall be reported as if it were a 100
percent interest.

Example.  A owns 10% of Company B, which owns 60% of
Company C, which owns 25% of the applicant.  Company B's
interest in the applicant would be 25% (the same as Company C's
interest since Company B's interest in Company C exceeds 50%),
and A's interest in the applicant would be 2.5% (0.1 * 0.25).  Under



the 10% attribution benchmark, Company B's interest in the
applicant must be reported on the applicant's FCC Form 175 Exhibit
A, while A's interest in the applicant need not be reported.  However,
if A owned 40% of Company B in the above example, then A's
interest in the applicant would be 10% (0.4 * 0.25), and the applicant
would need to report it on the applicant's FCC Form 175 Exhibit A.

  

Exhibit B - Agreements with Other Parties/Joint Bidding Arrangements:  Applicants must
attach an exhibit identifying all parties with which they have entered into any agreements,
arrangements or understandings which relate in any way to the licenses being auctioned, including
any relating to the post-auction market structure.  See 47 C.F.R. §1.2105(a)(2)(viii).  Note that
applicants that are nationwide bidders may not be parties to such agreements.  See Section IV.B.7,
above.

Be aware that pursuant to Certification (4) on the FCC Form 175, the applicant certifies that it will
not enter into any explicit or implicit agreements or understandings of any kind with parties not
identified in the application regarding bid amounts, bidding strategies, or the particular licenses the
applicant will or will not bid.  See 47 C.F.R..§ 1.2105(a)(2)(ix).  To prevent collusion, the
Commission's Rules generally prohibit communication among applicants for the same license
areas between the initial short-form applications filing deadline and the down payment deadline for
licenses won, when such communications concern bids, bidding strategies, or settlements.  47
C.F.R. § 1.2105(c).

Exhibit C - Status as a Small Business or Very Small Business:  Applicants claiming status as a
very small business or small business must attach an exhibit providing the following information
regarding this status.

Entity Required Information

Applicant Average gross revenues for the preceding three years set forth both
separately (e.g., for each of the three preceding three years
individually) and in the aggregate (for all of the preceding three
years combined).  Certification that the average gross revenues for
the preceding three years do not exceed the required limit, or
providing average gross revenues for the 3-year period without
providing the gross revenues for each of the preceding three years, is
insufficient.

Applicant's Affiliates
see 47 CFR § 27.502 same information required as discussed above

Applicant's
Controlling Interests
See Part II.C.1, above. 
See also 47 CFR § 1.2110. same information required as discussed above



Example.  The applicant had gross revenues of $500,000 in 1997,
$1,000,000 in 1998, and $3,000,000 in 1999, with average gross
revenues for that time period of $1,500,000.  The applicant owns
60% of Company A, making Company A an affiliate of the applicant
under Section 1.2110(b)(4)(i)(B), and Company B owns 52% of the
applicant (making Company B a controlling interest of the applicant,
as defined in Part II.C.1 of this public notice.  The applicant's Exhibit
C would look like this:

Applicant Name

1997 gross revenues $ 500,000
1998 gross revenues $ 1,000,000
1999 gross revenues $ 3,000,000

Average gross revenues
for the preceding 3 years $ 1,500,000

Company A (an affiliate of the applicant)

1997 gross revenues $    enter amount
1998 gross revenues $    enter amount
1999 gross revenues $    enter amount

Average gross revenues
for the preceding 3 years $    enter amount

Company B (a controlling interest in the applicant)

1997 gross revenues $    enter amount
1998 gross revenues $    enter amount
1999 gross revenues $    enter amount 

Average gross revenues
for the preceding 3 years $    enter amount 

TOTAL: combined average gross revenues for the
preceding three years of the applicant, the
applicant's affiliates and their controlling interests

NOTE: Each member of an applicant that is applying to bid as a consortium of small
or very small businesses must provide this information and qualify for the
claimed status.



Exhibit D - Information Requested of Designated Entities:  Applicants owned by minorities or
women, as defined in 47 C.F.R. § 1.2110(b), or that are rural telephone companies, may attach an
exhibit regarding this status.  This information, in conjunction with the information requested in
Block 10 of the FCC Form 175, will assist the Commission in monitoring the participation of these
“designated entities” in its auctions.

Exhibit E - Miscellaneous Information:  Applicants wishing to submit additional information
should include it in Exhibit E.

Applicants are reminded that all information required in connection with applications to participate
in spectrum auctions is necessary to determine the applicants' qualifications, and as such will be
available for public inspection.  Required proprietary information may be redacted, or
confidentiality may be requested, following the procedures set forth in 47 C.F.R. § 0.459.  Such
requests must be submitted in writing to Amy Zoslov, Chief, Auctions and Industry Analysis
Division, Wireless Telecommunications Bureau, Federal Communications Commission, 445 12th 
Street, S.W., Room 4-A760, Washington, D.C.  20554 (with a separate copy mailed to Howard
Davenport, Legal Branch, Auctions and Industry Analysis Division), in which case the applicant
must indicate in Exhibit E that it has filed a confidentiality request.  Because the required
information bears on applicants' qualifications, the FCC envisions that confidentiality requests will
not be routinely granted.

Waivers:  Applicants requesting waiver of any rules must submit a statement of reasons sufficient
to justify the waiver sought.  See 47 C.F.R. § 1.3.



XIII. ATTACHMENT H

ACCESSING THE FCC NETWORK USING
WINDOWS 95/98

This attachment describes how to access the FCC Network from a system that is running the
Microsoft Windows 95 or Microsoft Windows 98 operating system.  This involves configuring
dial-up network access and then performing the dial-up procedure.  Dial-up access to the FCC
Network is required to submit FCC Form 175 applications electronically or use the FCC Remote
Access System. 

Note:  Dial-up access to the FCC Network is not required to review FCC Form 175
applications.  You can perform that function from the Internet, by entering location
http://wtbwww15.fcc.gov/ on your Netscape Web browser and clicking the 175 Review
button.

Conventions

The instructions in this section use the following typographical conventions:

bold Represents objects on the screen that you click with the mouse pointer, including
buttons, Internet links, icons, tabs, menu items (e.g., Cancel button, Auctions
link, Save option in the File menu).

italic Represents field names or areas of a screen (e.g., Applicant field, Selected
Licenses area of a screen).

bold italic Represents characters that you must type exactly as they appear in the
instructions.  For example, if you are instructed to type http://wtbwww03.fcc.gov,
you should type all of the characters shown in bold italic exactly as they are
printed.

SMALL CAPS Represents keys on the keyboard (e.g., ENTER, CTRL, ESC).

Note:  Throughout these instructions, “enter” means to type the appropriate information and then
press the ENTER key.

E. Configuring Dial-Up Networking

1. To start dial-up networking:

a. Click the Windows 95/98 Start button. 
b. Click the Programs option to display the Programs menu.



c. Click the Accessories option to display the Accessories menu.
d. In Windows 95, click Dial-Up Networking.

In Windows 98, click Communications, then Dial-Up Networking.

If Dial-Up Networking is not an option on your Accessories menu, you should install it
from your Windows 95/98 CD or diskettes.

2. When the Dial-Up Networking window appears, double-click the Make New
Connection icon. 

The Make New Connection window appears.

3. If you are connecting to submit FCC Form 175 applications, type FCC Auctions 877# in
the field titled Type a name for the computer you are dialing. 

If you are connecting to use the FCC Remote Access System, type FCC Auctions 900# in
the field titled Type a name for the computer you are dialing.

Note: If you connect to the FCC’s 900# telephone service, there is a charge of
$2.30 per minute.  The first minute of connection time to the 900 number service
is at no charge.

4. In Windows 95, click the down arrow at the right of the Select a modem field and select
your modem from the menu of available modems. 

In Windows 98, click the down arrow at the right of the Select a device field and select
your modem from the menu of available devices.

If your modem does not appear on this list, you must install your modem driver according
to the modem manufacturer installation procedures, which are usually described in your
modem’s user manual.

5. Click the Next button. 

6. If you are connecting to submit FCC Form 175 applications, type 877 and 844-2788 in
the Area Code and Telephone Number fields, respectively.

If you are connecting to use the FCC Remote Access System, type 900 and 555-5554 in
the Area Code and Telephone Number fields, respectively.

7. Verify that the correct country is selected in the Country code field. 

If necessary, click the down arrow at the right of the Country code field and select the
appropriate country from the menu of available countries.



8. Click the Next button.

9. Click the Finish button. 

An icon labeled either FCC Auctions 877# or FCC Auctions 900# appears in the Dial-Up
Networking window.

10. Verify that properties are configured correctly before attempting a dial-up session.  Put
the mouse pointer on the FCC Auctions icon that you wish to configure and click the
right mouse button to display a menu.  Click Properties from the menu.

11. Click the Configure button.  Click the Options tab at the top of the Properties window.

12. In the Connection control area of the Options tab, verify that neither option is selected.  If
either option is selected, click the check box at the left of the option to deselect it.  Then
click OK.

13. In Windows 95, click the Server Type... button.

In Windows 98, click the Server Types tab at the top of the Properties window.

14. In the Advanced Options area, verify that only Enable software compression is selected. 
If it is not selected, click the check box at the left of the option to select it.  If either of the
other options is selected, click the check box to deselect it.

15. In the Allowed Network Protocols area, verify that only TCP/IP is selected. 

If it is not selected, click the check box at the left of the option to select it.  If either of the
other options is selected, click the check box to deselect it.

16. Click the TCP/IP Settings button.  On the TCP/IP Settings window, select Server
assigned IP addresses at the top and select Specify name server addresses midway down
the window.

17. Type 165.135.79.95 as the Primary DNS. 

Ensure that these two options are checked:

• Use IP header compression
• Use default gateway or remote network

18. Click OK on the TCP/IP Settings window and the Server Type window.

19. Close the Dial-Up Networking window.



20. a. Click the Windows 95/98 Start button, then click the Settings option to display the
Settings menu.

b. Click Control Panel and then double-click the Network icon.

c. Highlight the TCP/IP Protocol and click Properties.  If there are multiple TCP/IP
protocols, highlight TCP/IP --> Dial-Up Adapter and click Properties.

In a Windows 98 environment, a confirmation dialog appears.  Read the information
on the dialog, then click the OK button.

d. Click the DNS Configuration tab.

e. Select Enable DNS. Type bidder in the Host box, type fcc.gov in the Domain box,
then type 165.135.79.95 in the DNS Server Search Order box and click the Add
button.

f. Click OK on the TCP/IP Properties windows, then click OK on the Network
windows.

g. If you are prompted to restart your computer, click Yes to restart, then begin the Dial-
Up Procedure.

F. Dial-Up Procedure

1. If the Dial-Up Networking window is not currently open, do the following:

a. Click the Windows 95/98 Start button. 
b. Click the Programs option to display the Programs menu.
c. Click the Accessories option to display the Accessories menu.
d. In Windows 95, click Dial-Up Networking

In Windows 98, click Communications, then Dial-Up Networking. 

The Dial-Up Networking window appears. 

2. In the Dial-Up Networking window, double-click the FCC Auctions 877# or FCC
Auctions 900# icon.

Note: If you connect to the FCC’s 900 number telephone service, there is a charge of $2.30
per minute.  The first minute of connection time to the 900 number service is at no charge.

3. Click the Connect button on the window.  Do not enter User name and Password .



The Connection window appears, indicating the status of your connection as your modem
dials into the system.  This window must remain running during your dial-up session.  You
may minimize the window, if you wish.

If your modem fails to establish a connection, please see the Troubleshooting section below.

4. Once the connection is established, open your Web browser. 

5. In your browser’s Location field, enter the appropriate Universal Resource Locator (URL) as
follows:

• For FCC Form 175 Submit, enter http://wtbwww34.fcc.gov (primary location) or
http://wtbwww04.fcc.gov (secondary location)

• For the FCC Remote Access System, enter http://wtbwww26.fcc.gov (primary location)
or http://wtbwww03.fcc.gov (secondary location)

If nothing appears in your Web browser, please see the Troubleshooting section below.

6. When you have finished, exit the Web browser, then click the Disconnect button on the
Connection window to end your dial-up session.

G. Troubleshooting

Following are problems you may encounter and possible solutions for resolving or isolating
them.

1. Modem does not respond

1. Confirm that all physical connections for the modem are present.

2. Confirm that the phone line is active by connecting it to a telephone and checking
        for a dial-tone.

3. If you are dialing the 900 number service, check for a 900 number telephone block. If the
volume settings are low, the modem may be dialing but not connecting.  Check for this by
trying to connect to the 877 number, or by dialing the 900 number on that line using a
telephone.

4. Confirm that the correct modem driver is installed for your modem.



2. Modem dials but does not connect

1. If you are dialing the 900 number service, check for a 900 number telephone block. Check
for this by dialing the 877 number to see if you connect, or by dialing the 900 number on
that line using a telephone.

2. Confirm that the number the modem is dialing is correct.

3. Confirm that the modem prefix, if any, is correct.

3. Modem dials and connects, but nothing appears when you enter the
Location in the Web browser 

1. Verify the Dial-Up Networking settings specified in the Configuring Dial-Up
        Networking section.

2. Confirm that your Web browser is not using proxies:

a) On your browser, click the Preferences option in the Edit menu.
b) In the Category area at the left, double-click Advanced.
c) Click the Advanced structure’s Proxies option.
d) Click the radio button labeled Direct connection to the Internet.
e) Click the OK button at the bottom of the window.

4. Receive an Internal Server error in the Web browser

1. Confirm that the Location is correct.

2. Confirm that Java and JavaScript are enabled in your Web browser, and confirm that
Cookies is set to Accept All.

H. Help

For technical assistance with installing or using FCC software, contact the FCC Technical
Support Hotline at (202) 414-1250 (V) or (202) 414-1255 (TTY).  The FCC Technical Support
Hotline is generally available Monday through Friday, from 8 a.m. to 6 p.m. ET. All calls to the
FCC Technical Support Hotline are recorded.


